
Installation and  

Application Walk-Through 

 
 

MarineCadastre.gov 

October 14, 2011 

 

AIS Data Handler 



Introduction to AIS 

 Automatic Identification Systems (AIS) monitor ship traffic for the purpose of 

improving safety of navigation world-wide. These systems also provide coastal 
planners with insight to marine transportation patterns over long periods of time. 
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The AIS Data Handler 

• To make this data more accessible to users, the AIS Data Handler website provides 
software and ready-to-use data for coastal planners. 

 

• The AIS Data Handler can be used to perform quality control checks on the raw 
data, query the data based on particular user needs, and analyze the marine 
transport patterns in a given region 
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AIS Data Handler Website 

• http://marinecadastre.gov/ais/ 

 

• Downloads available to the public: 
AIS Data Handler ArcMap Add-In 

AIS Data Handler Pre-Processor 

AIS Data Metadata 

AIS Data Handler source code (for developers) 

AIS Tutorial (this document) 

AIS Sample data for the Miami port area  

 

• For an account to download data, 

      request a user name and password 

      by email from:  

      nos.csc.aisdata@noaa.gov 
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Data Access: AIS Data Handler Website 
 

• To download data: 

1. http://marinecadastre.gov/ais/ 

 

2. View the index map to choose your UTM region(s) of interest; 

 Alaska: 1 thru 9 

 Hawaii: 4 and 5 

 East Pacific: 10-12 

 Gulf of Mexico: 14-16 

 Atlantic: 17-19 

 

3. Select zone and 

       Login  
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Data Access: AIS Data Handler Website 

4. You will be redirected to a table 
 of datasets for that region 

 

5. Download datasets for the 
 timeframe of interest (datasets 
 range from 100 MB to 1.5 GB) 
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AIS Data Structure 

 

File Geodatabase (FGDB) Structure 

• An ESRI file structure which can efficiently store large amounts of data and is 
contained within a single folder structure for manageable access. 

• All data processed with the AIS Data Handler must be in FGDB format (tools 
are provided to process raw data into this format). 

• FGDB’s are subset by month and UTM zone to account for file size. 

• Voyages were created using unique combinations of vessel IDs (MMSIs) and 
destination values. 

 

Relationship Class 

• A method of linking data tables  using common attribute values. 

• The AIS FGDB’s contain two relationship classes linking dynamic data to static 
and voyage data. 
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AIS Data Structure 
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AIS Data Structure 

Broadcast Features 
 
SOG 
COG 
Heading 
ROT 
DateTime 
Status 
MMSI 
Voyage ID 
Receiver Type 
Receiver ID 

Vessel Table 
 
MMSI 
IMO 
Call Sign 
Name 
Type 
Length 
Width 
Dimension 
Components 
 

Voyage Table 
 
Voyage ID 
Destination 
Cargo 
Draught 
ETA 
Start Time 
End Time 
MMSI 
 
 

BroadcastHasVessel 
Relationship Class 
Key = MMSI 

BroadcastHasVoyage 
Relationship Class 
Key = VoyageID 
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AIS Data Structure 
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AIS Data Handler Add-In 

The AIS Data Handler is an ArcGIS Desktop Add-In that allows users to display, clean, 
filter, and analyze the AIS data extracted from the AIS Data Handler website.  

 

Cleaning tools allow users to read, edit, create, and delete records based on a set of 
rules involving spatial, temporal, and attribute properties.  

 

Filter and query tools allow users to subset data in space, time, or by attribute for 
further analysis.  

 

Analytical tools include the ability to create derived products such as vessel tracks & 
vessel densities and to calculate summary statistics for the AIS datasets.  
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Installation of AIS Data Handler Add-In 

Step 1. Download the AIS Data Handler from the website 
(http://marinecadastre.gov/ais) by clicking on the AIS Data Handler ArcMap Add-In 
link and follow your browser’s instructions.   

 

Step 2. Once downloaded, double-click on AISDataHandlerSetup.exe to install. In the 
installation dialog, click the Next button to accept default installation parameters 
and Finish to open the ArcMap customization instructions.  Steps 3 through 7 
provide an overview of these instructions. 

 

Step 3. Open ESRI ArcMap 10.x* 

 

12 
AIS Data Handler Walk-Through            

* This Add-In application ONLY works with ArcMap 10.x, version 9.3 is unsupported.  
Use of an ArcEditor or ArcInfo level license is strongly recommended. 



Installation of Data Handler Add-In 
Step 4. In ArcMap, choose the following: 
 -Customize (on task bar)  [5a] 
 -Customize Mode  [5b] 
 -Commands (middle tab) [5c] 
 -AIS Data Handler (under “Categories” in the 

left column)   [5d] 

 
 
 
 
 
 
 
 
 
 
 
 
 

Step 5. Drag the “AIS Data 
Handler ” from “Commands” 
in the right column onto a 
toolbar in ArcGIS         [6] 
 

Step 6. Close the customize 
window 
 

5b 

5a 

5c 

5d 

6 
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Installation of AIS Data Handler Add-In 

Step 7. Load AIS data into ArcMap from a File Geodatabase by pressing “Add Data” 
button (to begin the Broadcast feature class and Vessel and Voyage tables should 
be loaded; relationship classes are not added as layers to the map). 

 

 

 

 

 

 

 

 

 

 

Step 8. Press the AIS button to open the AIS Data Handler dialog. 
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Installation Files 

File Name Description 

SandDock.xml Form rendering configuration file 

SandDock.dll Form rendering controls 

Gigasoft.ProEssentials.xml Graphing configuration file 

Gigasoft.ProEssentials.dll Graphing controls 

ESRI.ArcGIS.Desktop.AddIns.dll ESRI desktop Add-Ins classes 

AISDataHandler.tlb Type library to deploy com components from C# 

AISDataHandler.esriAddIn AIS Add-In installation file 

AISDataHandler..dll AIS Handler Interface and Functions 

AISDataHandler..mdb AIS configuration file 

Clean_FeatureClass.py Functions for cleaning  broadcast 

Clean_Table.py Functions for cleaning vessel and voyage 

filter_fortrackgen.py Filter functions 

PurposefulMotion.py Purposeful Motion track generation 

15 
AIS Data Handler Walk-Through            



AIS Data Handler: Sample Work Flows  
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Sub-setting Data 
 

 

AIS datasets can be very large and process times can often run in the range of several 
hours.  

 

Consider working with a sample of Broadcast records (under 1,000,000) to develop 
your methods and workflows. Use one of the following native ArcGIS tools to make 
your sample.  

 

• System Toolboxes>Editing Tools>Erase Point 

• An edit session 

• System Toolboxes>Data Management Tools>Features>Copy Features (w/GP 
extent set) 

• The Copy Features command will require new relationship classes to be built 
for the new feature classes and tables, and the Erase Point command can take 
many hours to reduce a 12 million record set to 1 million. 

 

17 
AIS Data Handler Walk-Through            



Sub-setting Data 
 

• When subsetting data it is important to preserve the relationship classes between 
the Broadcast feature class and the Vessel and Voyage tables.  

 

• The easiest way to preserve the relationships is to delete data directly from the 
existing feature classes in an edit session(this may take a long time for larger 
datasets). 

 

• To create copies of related data, use ArcCatalog to select all participants in the 
relationship, including the relationship class itself, and use the copy/paste utilities 
in ArcCatalog. 
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The AIS Data Handler Interface 

The AIS Data Handler is divided into 5 functional areas; each with multiple tools.  
This tutorial will explain the purpose of each tool. 

Tool 
Selection Tool Boxes 

Input Data 

Output Data 

Note: The 
available tools 
will vary based 
on the type of 
input data 
selected. 
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Clean Toolbox 

Some of the data broadcast via AIS is updated automatically (e.g. position, time, speed, and 
heading), and other records are operator provided and therefore subject to human error.  
Operators may not understand how to define parameters correctly, may not update time 
varying parameters with enough frequency, or may disregard the importance of providing 
accurate information.    
 
Users of AIS data may not be able to properly characterize messages with incomplete vessel 
or voyage information and therefore may want to remove this information from the dataset.   
 
The Clean Toolbox allows the user to eliminate data from an AIS dataset that does not meet 
quality control requirements. This toolbox consists of 14 individual tools, each of which can 
be applied to some or all portions of the individual dataset (i.e., Broadcast, Vessel, or 
Voyage information).  
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Clean Toolbox 

Clean tools can be applied individually or batched together depending on user preference. 
Batch clean operations will be significantly faster than running sequential individual 
operations in because the AIS dataset is only read once for a batch operation.  When 
records are discarded from one dataset, related records in the other tables are also 
discarded. 
 
When a clean operation is applied, copies of the dataset, the related tables, and the 
relationship classes are also created and records are removed according to the cleaning 
operations selected.  
 
 
Note:  Maintenance of relationship classes during cleaning operations requires an ArcInfo 
license.   
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Cleaning Tools by Data Type 
Broadcast Vessel Voyage Tracks 

Clean MMSI 
Length and 

Country Codes 

Clean MMSI 
Length and 

Country Codes 
 

Clean MMSI 
Length and 

Country Codes 
 

Clean MMSI 
Length and 

Country Codes 
 

Clean Status 
Entries 

Clean Vessel 
Name Entries 

Clean Voyage ETA 
and End Times 

Clean Voyage ETA 
and End Times 

Clean Speed 
Over Ground 

(SOG) 

Clean Vessel 
IMO Entries 

Clean Voyage 
Cargo Entries 

Clean Voyage 
Cargo Entries 

Clean Number 
of Reports Per 

MMSI 

Clean Vessel Call 
Sign Entries 

Remove 
Duplicate 

Entries 

Clean Vessel 
Shiptype Entries 

Remove 
Broadcast Data 
Without Static 

Records 

Clean Vessel 
Dimensions 

Remove 
Inconsistent 
Static Data 
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Tool Overview:  
 Clean MMSI Length and Country Codes 

Tool Description: 
Maritime Mobile Service Identity (MMSI) are nine-digit numbers used to uniquely 
identify a vessel. Base stations also have MMSIs, which should consist of seven digits. 
The first three digits of all MMSIs consist of Maritime Identification Digits (MID) 
which are used to identify the region and country of origin of a ship.  

 
While these MMSI numbers are vessel and base station specific, they often are 
invalid in that they do not consist of the appropriate number of digits. This tool 
removes all entries that do not have the appropriate number of digits or that do not 
have valid MIDs. 

 
Applicable Datasets: 

Broadcast, BaseStations, Vessel, Voyage, Tracks 
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Tool Implementation Steps:  
 Clean MMSI Length and Country Codes 

1. Select the Desired AIS Input Dataset 

2. Check the “Clean MMSI Length and 
Country Codes” Box 

4. Select Data by the Country of 
Origin in the pop-up “Country 
Code Options” Box 

3. Press Options 
(will appear when 
box is checked) 

5. Define the suffix of the subset data to be output (will 
not overwrite original data) 

6. Press “Clean” 
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Original 
Dataset 

Processed 
Dataset 

Output Overview:  
 Clean MMSI Length and Country Codes 

Points that did not 
satisfy the 
requirements are 
removed as is 
evident on the map 
and in the tables. 
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Tool Overview:  
 Clean Status Entries 

Tool Description: 
The navigational status of a vessel is conveyed in each position report through one of 
15 codes, which include “under way using engine” (code 0),  “at anchor” (code 1),  
and “fishing” (code 7).  

 
Based on user error,  an invalid navigational status may be included in the position 
report. This tool removes all entries with invalid navigational status codes. 

 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
 Clean Speed Over Ground (SOG) 

Tool Description: 
In each position report the speed of the vessel is conveyed and is reported as speed 
over ground (SOG). Errors in dynamic data such as SOG are possible due to faulty 
GPS or AIS transmitter equipment. This tool allows the user to define lower and 
upper thresholds for the speed over ground category. 
 
Many types of analyses are directed as moving vessels; for theses situations it may 
be useful to remove SOG values of 0.  Removing these values is particularly useful for 
density grid generation. 

 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
 Clean Number of Reports per MMSI 

Tool Description: 
MMSI values are transmitted multiple times per minute. Therefore there are 
typically many records tagged with a single MMSI in each dataset. 

 
In some cases there may be very few records with a particular MMSI, especially if 
the vessel remains far offshore and its signal is not always recorded. In this case the 
user can eliminate any vessel from the dataset which does not have greater than the 
specified number of reports. 

 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
 Remove Duplicate Entries 

Tool Description: 
Land based receivers record the broadcasted AIS information. Depending on the 
location of the vessel, more than one receiver may record the same position report.   

 
Duplicate data points may affect further processing of the AIS data and it is advisable 
to remove them. This tool removes all duplicate position reports. 

 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
  Remove Broadcast Data without Static Records 

Tool Description: 
MMSI values are included in both position messages and in static data reports.  A 
clear picture of the ship’s purpose and movements therefore cannot be attained 
without both message types.   

 
It may be desirable for some users to ensure that they are only dealing with vessels 
that are broadcasting both position and static data reports. This tool allows the user 
to remove position reports that don’t have corresponding static  data reports. 

 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
 Clean Vessel Name Entries 

Tool Description: 
Vessel information such as the vessel name is specified by the vessel operator and 
should correspond to the documented name of the craft.  

 
Based on user error there may be issues with the vessel name entry. This tool can 
identify and remove records when the vessel name is empty, has multiple spaces, 
has special (non-Latin) characters, or has a user defined character included. 

 
Applicable Datasets: 

Vessel 
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Tool Overview:  
 Clean IMO Entries 

Tool Description: 
Vessel information such as the IMO ship identification number is specified by the 
vessel operator. 
 
Based on user error there may be issues with the IMO entry. This tool can identify if 
the IMO entry is invalid and removes the non-compliant data. 

 
Applicable Datasets: 

Vessel 
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Tool Overview:  
 Clean Call Sign Entries 

Tool Description: 
Vessel information such as the Call Sign is specified by the vessel operator. 

 
Based on user error there may be issues with the call sign entry. This tool can 
identify and remove invalid call sign entries based on 4 criteria that can be selected 
by the user. 

 
Applicable Datasets: 

Vessel 
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Tool Overview:  
 Clean Shiptype Entries 

Tool Description: 
Vessel information such as the ship type are sent out with each report. This attribute 
is particular to the vessel and  should remain consistent throughout the voyage. 

 
Inconsistent values for the ship type may indicate a larger problem in the data 
associated with a particular vessel as the information is expected to change very 
infrequently.  This tool removes data when the ship type is inconsistent. 

 
Applicable Datasets: 

Vessel 
 

34 
AIS Data Handler Walk-Through            



Tool Overview:  
 Clean Vessel Dimensions 

Tool Description: 
Vessel information such as the vessel dimensions are defined by vessel operators 
sent out with each static data report. Users can clean the Vessel table based on 
vessel dimensions by setting length and width thresholds.   

 
 
Applicable Datasets: 

Vessel 
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Tool Overview:  
 Remove Inconsistent Static Data 

Tool Description: 
Vessel information such as MMSI, IMO, Name, Call Sign, and dimensions  are sent 
out with each report. These types of data are particular to the vessel and  should 
remain consistent throughout the voyage. 

 
Inconsistent values for these static parameters may indicate a larger problem in the 
data associated with a particular vessel as the information is expected to change 
very infrequently.  This tool removes data where this vessel information is 
inconsistent. 

 
Applicable Datasets: 

Vessel 
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Tool Overview:  
 Clean Voyage ETA and End Times 

Tool Description: 
Each vessel provides information on the expected time of arrival (ETA) to its 
destination; voyage start and end times are estimated based on broadcast 
destination changes. 
 
The user may specify to limit the data based on the ETA and start or end times of the 
voyage. By setting the Early and Late Thresholds, uses can identify ships that arrive at 
their destinations within a certain periods of time from their ETA.   

 
Applicable Datasets: 

Voyage 
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Tool Overview:  
 Clean Voyage Cargo Entries 

Tool Description: 
Each vessel provides information on the type of cargo that is being transported. 
 
The user can eliminate all data that has non-valid/non-descriptive values for voyage 
cargo, based on the following four criteria: 
 -No Additional Information Values 
 -Not Available Values 
 -Future Use Values 
 -Regional Use Values 

 
Applicable Datasets: 

Voyage 
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Query Toolbox 

The query process will not 
create a new dataset nor will it 
delete values, it will simply 
select the entries that comply 
with the requested criteria.   
 
This process is equivalent to 
using the definition query in 
the ArcMap Layer Properties 
and these definition queries 
can be viewed from the layer 
properties dialog. 

Because AIS data sets are typically very large, it can be beneficial to subset this feature 
classes using varying techniques. This toolbox consists of 4 individual tools, each of which 
can be applied to some or all portions of an individual dataset (i.e.., Broadcast, Vessel, or 
Voyage information). A query may be performed on the data to select values based on the 
country of origin, the navigational status of the vessel, the vessel type, or the cargo type.  
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Tool Overview:  
 Query by Country 

Tool Description: 
The purpose of this tool is to limit the selection to vessels from a specified country of 
origin.  A pop up box appears when using this tool that enables the user to choose 
which countries of origin to use in the selection. 

 
Applicable Datasets: 

Broadcast, Vessel, Voyage 
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Tool Overview:  
 Query by Status Type 

Tool Description: 
The purpose of this tool is to select broadcast points according to vessel status.  
Users can select vessel statuses of interest using the status options dialog.   
 

Applicable Datasets: 
Broadcast 
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Tool Overview:  
 Query by Vessel Type 

Tool Description: 
The purpose of this tool is to select  vessels based on vessel type. Users can select 
vessel types of interest using the vessel type options dialog.  
 

Applicable Datasets: 
Vessel 
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Tool Overview:  
 Query by Cargo Type 

Tool Description: 
The purpose of this tool is to select  voyages based on cargo type. Users can select 
cargos of interest using the cargo options dialog.  
 

 
Applicable Datasets: 

Voyage 
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Tool Overview:  
 Removing Queries 

Tool Description: 
Queries can be removed in two ways.  Users can either click the clear button or 
uncheck the selected query and press the Query button. 

 
Applicable Datasets: 

Broadcast, Voyage, Vessel 
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Analyze Toolbox 

The Analyze Toolbox also provides 
an Area of Interest tool to select a 
focus area that the statistics, the 
tracklines and density functions will 
operate within.  

This toolbox allows the user to analyze the vessel traffic in three modes. First, statistics can 
be calculated on features, tables and subsets of records. Second, vessel tracklines can be 
created from the Broadcast records. Third, raster density maps can be created from either 
the Broadcast or the trackline values. 

Area of 
Interest 

Statistics Density 
Create 

Trackline 
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Tool Overview:  
 Area of Interest 

The AOI function is part of the Analyze tools. It is best used after the Broadcast records 
have been cleaned. An AOI will not limit the geographic extent of a clean operation. It 
will act as an analysis mask and is respected by the following analysis functions: 

• Statistics – tabular and graphical 
statistics for Broadcast points and 
tracks 
 
• Density – all options 
 
•Tracks – create from all data option 
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Tool Overview:  
 Area of Interest 

 
 Input Feature Extents 

Uses the extent of the input dataset  
defined in other Analyze tabs. 
 

 Map Extents 
Uses the current  map extent within 
ArcMap. 
 

 Draw AOI 
Draw a polygon directly on the map. 
This AOI option can be cleared by using 
the Clear AOI button. 
 

 Layer Extents 
Uses the extent of any dataset that is 
loaded into ArcMap.  

  

Four options are provided to build an Area of Interest for subsequent analyses: 

Draw AOI Button 

Clear AOI Button 
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Tool Overview:  
 Statistics 

Statistics can be generated for each data type 
selected in the layer menu and for the area 
defined by the “Area of Interest” tab.  
 
Depending on the user settings, graphical or 
tabular results can be generated as shown 
below. For both types of information, the data 
can be saved to a CSV file by pressing the “Save” 
button on the lower right hand side. 

  

Graphical Result Tabular Result 
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Statistics Available by Data Type 

Data Type Statistic Type of Statistic 

Graph Value (Tabular) 

Broadcast Count Position Points X 

Average Speed Value X X 

Speed Distribution X 

List  of Statuses X X 

Vessel Average Vessel Length X 

Vessel Length Distribution X 

Average Vessel Width X 

Vessel Width Distribution X 

List of Vessel Types x X 

Voyage Average Vessel Draught X 

Vessel Draught Distribution X 

List of Voyage Cargos X X 

Tracks (this data 
type can be 

created with the 
Analyze Tools) 

Count Voyage Tracks X 

Average Vessel Draught X 

Vessel Draught Distribution X 

Total Distance X 
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Tool Overview:  
 Density 

Note: Spatial Analyst must be installed and enabled to use this tool. 

The purpose of this tool is to generate a raster-based density map. The following 
information must be provided: 

Information What it means 

Layer Select the Broadcast or Tracks input layer from the geodatabase. 

Population Field This option can be used to add a weighted factor to the broadcast points 
or vessel tracks.  Users can add fields defining these weights to the 
feature class attribute table and then set one of those fields as the 
Population Field.  Setting a Population Field of ‘none’ will ensure that no 
weighting factor is used. 

Density Type Point/Line: Density calculated based on a  neighborhood around each 
raster cell center; the number of points that fall within the neighborhood 
is totaled and divided by the area of the neighborhood. 
Kernel: Density is calculated based on a neighborhood function that 
spreads the value of each point over the given radius according to a 
quadratic formulation. 
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Tool Overview:  
 Density 

Note: Spatial Analyst must be installed and enabled to be able to use this tool. 

Information What it means 

Analysis Radius The search radius with which to calculate density.  

Output Cell Size The cell size desired in the output raster dataset. 

Density Units Option to calculate the density units in terms of number per square 
kilometer or per square mile. 

Base Name Suffix assigned to input file name to identify the output file. 

Analysis Spatial 
Reference 

A user defined spatial reference for the density tool calculation. The 
default is “World_Mercator”. 
 
The user can also decide whether to have the output projected into the 
same coordinate system as the input file or into the coordinate system as 
defined for the density analysis. 
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Tool Overview:  
 Density 

Example of Density Inputs for Broadcast Points 

52 
AIS Data Handler Walk-Through            



Tool Overview:  
 Density 

Example of Density Output from Broadcast Points 
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Tool Overview:  
 Density 

Example of Density Inputs for Tracks 
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Tool Overview:  
 Density 

Example of Density Output from Tracks 

55 
AIS Data Handler Walk-Through            



Tool Overview:  
 Tracks 

The purpose of this tool is to generate tracklines from Broadcast points.  Vessel tracklines 
can be easier and faster to display then Broadcast points, and can result in higher quality 
density analysis then with Broadcast points.  In conjunction with the cleaning and filtering 
tools, smooth and logical vessel tracklines can be created from the AIS data. 

56 
AIS Data Handler Walk-Through            



Tool Overview:  
 Tracks 

Options for the Creation of Tracks 
 
1) Create Tracks from All Data Points 
 

 Input Data:  feature class containing position reports and maximum 
time allowed between sequential track points.   Broadcast points will be 
linked into tracklines, based on VoyageID and the time between points.  
If the time between points exceeds the threshold set, a new trackline 
will be generated.  A threshold setting of 60 minutes is recommended. 

 
2) Create Tracks Based on Time Interval 
 

Input Data: feature class containing position reports and user defined  
time interval.  Tracks will be created based on a positions report’s MMSI 
and timestamp. 
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Tool Overview:  
 Tracks 

3) Create Tracks Using Purposeful Motion: (Calder and Schwehr, 2009).  

Recommended Values: 
Initial SOG: 0.5 knots 
End SOG: 0.2 knots 
End Time: 300 seconds (5 minutes) 
End Gap: 600 seconds (10 minutes) 
 

 
Input Data: feature class containing position reports and user defined speed and 
timing thresholds.  Tracks will be created based on vessel’s MMSI, speeds, and 
time between broadcasts.   
 
Processing: Five thresholds are used to initiate and end voyages.  When the SOG 
is greater than the Initial SOG threshold a transit is started.  If the SOG falls 
below the End SOG threshold for a length of time longer than the End Time 
threshold.  Voyages are also considered over if the End Gap threshold is 
exceeded.  Once a set of voyages is produced, the Minimum Positions threshold 
is used to eliminate those voyages made up of a small number of position 
reports. 
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Tool Overview:  
 Tracks 

Example of Creating Tracklines from Point Data for a Single Vessel 
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Filter Toolbox 

The filter toolbox contains two tools which enables the user to remove outlier positions. 
This results in more realistic ship tracks by removing points that clearly should not be 
associated with a given track. Each point associated with a voyage can be tested to see if the 
distance between points exceeds a user defined value. The filter tools can also be used to 
smooth existing tracklines. 
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Tool Overview:  
 Filter positions by maximum distance 

Tool Description:  Use this to specify a maximum distance between Broadcast points that 
are associated with a specific voyage.  
 
The only information that needs to be input for this tool is the maximum allowable 
distance between points. 
 
Applicable Datasets: 

Broadcast 
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Tool Overview:  
 Smooth Voyage Tracks 

Tool Description: This tool provides capabilities to smooth voyage tracks that have 
already been created using the Analyze toolbox. 
 
Two methods of smoothing are enabled within this tool, as described below: 
 

PAEK : Uses a parametric continuous averaging technique to smooth the track lines. 
When using the PAEK smoothing, a tolerance must be defined, which is the length of 
a moving path along the line segments which is used in the smoothing algorithm. 
Bezier Interpolation: Fits Bezier curves through each line segment such that all 
vertices are maintained. No tolerance setting is required. 

 
Two additional pieces of information may also be input into the tool.  The first keeps the 
endpoints in fixed positions (i.e.. Not re-interpolating the start and end positions). 
Additionally, the tool can flag potential topological errors. 
 
Applicable Datasets: 

Tracks 
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Tool Overview:  
 Smooth Voyage Tracks 

Example of Smoothing Techniques 

Source: ArcGIS Desktop Help Online 
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Tool Overview:  
 Smooth Voyage Tracks 

Smoothing of actual voyage track: 

BEZIER Interpolation PAEK 
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Aggregate Toolbox 

The processing and analysis of the AIS data may result in a collection of individual data 
products that span a large geographic area or time frame. This tool is specifically designed 
to aggregate these multiple AIS products into one data set. This new data set can then be 
further processed using other tools in the AIS Data Handler. 

File Geodatabase of Sources 
to Merge 

Individual Datasets to 
Merge 

Output Destination Folder 

Name of Geodatabase to Create 
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AIS Pre-Processing Tools 

 Preparing raw AIS data in the NMEA format for use in the AIS Data Handler is a 2 
step process. Records must first be filtered and than translated. 

 

• Filtering AIS data reduces the position message frequency from 3 to 8 seconds 
down to a user defined frequency. 

• The AIS Pre-Processing tools contain an executable file called AISFilter that can be 
used to filter raw AIS data. 

• See the Appendix A, for a flow chart of the filter logic. 

• Translating the filtered NMEA data into the FGDB requires several of the AIS 
messages and results in a new set of records based on the data model described 
earlier in this tutorial. 

• The AIS Pre-Processing tools contain an ArcMap Add-In called ConvertAISToFGDB  
to convert raw AIS data into a FGDB format. 

 

(for advanced users) 
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AIS Pre-Processing Tools 
Installation 

Step 1. Download and the AIS Preprocessing tools from the AIS Data Handler website, 
(http://marinecadastre.gov/ais/addin.php) 

 save to the ArcGIS \\Bin\AddIns folder 

 

Step 2. Navigate to the ArcGIS \\Bin\AddIns folder and unzip AISPreprocessingTools.zip 

 Note: Use of AISFilter.exe (for filtering raw AIS data) does not require any further 
installation.  Instructions for use of AISFilter.exe are provided in a following slide. 

 

Step 3. Double click ConvertAISToFGDB.esriAddIn & choose “Install Add-In” 

 

Step 4. Open ArcMap and add the ConvertAISToFGDB tool  to an ArcMap toolbar using 
the customize dialog and instructions provided earlier in this tutorial. 
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AIS Pre-Processing Tools 

Parameters: 

• Input directory containing raw data files 

• File name pattern (to specify a subset of input files if desired) 

• Output directory with file name prefix 

• Filter interval in seconds 

• Comma delimited list of UTM zones 

 

Filtering with AISFilter.exe 
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AIS Pre-Processing Tools 

Sample .bat file 
 

“C:\Program Files (x86)\ArcGIS\Desktop10.0\Bin\Add-Ins\ ConvertAISToFGDB 
\AISFilter.exe"  

 E:\GISData_General\AIS\SampleRawNMEA 2009_06*.txt  
 E:\GISData_General\AIS\Test\June 60 1,2 
 

rem E:\GISData_General\AIS\SampleRawNMEA                      //Input directory containing raw data files 
 
rem 2009_06*.txt               //file name pattern - used to specify a subset of the input files 
 
rem E:\GISData_General\AIS\Test\June                                  //output directory with file name prefix 
 
rem 60                                        //filter interval in seconds

  
rem 1,2                      //comma delimited list of UTM zone  

Filtering with AISFilter.exe 
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AIS Pre-Processing Tools 

Converting to FGDB 

To convert from raw AIS data format to FGDB: 

1. click the ConvertAISToFGDB button in ArcMap 

2. Browse to the directory of AIS files 

3. Click Ok 

4. The ConvertAISToFGDB Add-In will automatically convert each input file to an 
individual FGDB following the data model described above. 
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AIS Processing Tips and Troubleshooting 

• Make sure to select the correct input table for each Clean function; selecting a Broadcast 
feature class to clean a vessel record requires the function to unnecessarily traverse the 
relationship classes which is time intensive. 
 

• The Input Layer field has a fixed field length for display, long file names my make it difficult to 
use. 
 

• Triggering the Clear Query function will clear the query; it does not removing the check from 
the query list of options. 
 

• After clearing a Query, toggle the draw button in the ArcMap table of contents to refresh your 
view. 
 

• Smoothing track lines relies on a map unit value, consider working in projected coordinates. 
 

• To build your own relationship classes between the Broadcast, Vessel and Voyage tables use; 
ArcToolbox>Data Management Tools>Relationship Classes>Create Relationship Class. 
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AIS Processing Tips and Troubleshooting 

• Correct relationship class settings can be found by reading the property values in one of the 
original relationship classes. 
 

• When removing a large number of records from a feature class, ArcGIS may leave behind 
orphan-empty records. The new feature class will function, however it will retain the overall 
files size of the original. Exporting the new feature class to a new FGDB will remove the 
orphan records. 
 

•  The Filter Positions by Maximum Distance function is intended to remove outliers. If a voyage 
has a significant break in its broadcast records, the later records may be removed with this 
filter. 
 

• To improve performance always include in the Table of Contents the tables needed for each 
process. 

 
•  If the Add-In does not appear in the Customize>Customize Mode>Commands listing in 

ArcMap, double click of the “AISDataHandler.esriAddIn” file in the ArcGIS install directory 
under Desktop>AISDataHandler. 
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Appendix A: NMEA Filter Logic 
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Appendix B: Miami Sample Data  
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January 1-31 2009 
Approximately 750 square miles 
33 MB 
  
1,365,578 Broadcast records 
188,583 Voyage records 
2,584 Vessel records 
  
802 unique MMSI’s in the Broadcast records 
31 unique MMSI’s in Vessel records with 2,550 null values  
2,141 unique MMSI’s in the Voyage records (17,833 with 0 values and 1,448 with 999999999 values) 
  
1,444 unique VoyageID’s in the Broadcast records 
157,015 unique VoyageID’s in Voyage records with 5,020 null values 
  
Clean for MMSI length and valid country codes: 15 minutes (reduced to:1,333,431 records) 
Clean to remove <1 knot records: 13 minutes (reduced to 192,062   records) 
Analyze>Statistics>List Vessel Types in Vessel: under 1 minute 
Analyze>Statistics>List Voyage Cargos in Voyage: under 1 minute 
Analyze>Statistics>Average Draught in Voyage:  under 1 minute 
Analyze to build tracks from all data using a 60 minute maximum gap: 1 minute (2,318 new tracks) 
Analyze>Statistics>Sum Distance using Tracks: under 1 minute (583 degree units) 
Analyze>Statistics>Density using Tracks: under 1 minute 
 

Specifications and example processing times 
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